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ArcGIS online Introduction 
ArcGIS online offers many tools and applications to create simple and more complex maps on the web. 

These maps can be shared to the public and can also be created into different web applications for users 

to view. A public account can be created for free and allows storage of up to 2GB of content that 

includes shapefiles (compressed into a zip folder), kml files, delimited text files (.txt or .csv), as well as 

maps and web applications that have been created.  

 

In this tutorial you will learn how to use many features in ArcGIS online including creating basic maps, 

adding in layers, changing the symbology of the layers and creating and sharing web applications. Once 

you have finished this tutorial, you should have a high understanding of the main functions of ArcGIS 

online and be able to produce simple maps by using data available online through their server as well as 

learning how to upload and use your own data from multiple sources.  
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Module 1: How to create a basic map on ArcGIS online 
In this first module you will learn how to use the basic functions of ArcGIS online. This includes a 

step-by-step process of creating an account; adding a basemap; and creating points, lines and 

polygons.  

Creating a public account with ArcGIS online 

 
Open up ArcGIS.com. 

Open a new internet browser and enter this address (http://www.arcgis.com/home/) in the 

address bar. When you see a webpage shown below, click Sign In. 

 

 
 

 
Sign up or sign in to ArcGIS.com with your Esri Global Account 

If you are a first time user, you will need to click ‘Create a public account’ and then follow the 

website’s step by step instructions to create one. Once you sign in, you will notice that your 

first name will appear where it previously said 'sign in'. 

 

http://www.arcgis.com/home/
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Opening a Map, Adding a Basemap and then Saving it 

  

 Opening up the map feature in ArcGIS online 

Once you have successfully logged in, click on the Map tab along the top of the ArcGIS online 

home screen. This will pull up a new blank map named My Map that looks like the image below: 
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There are many important features available on the map home page. On the left, there is a 

sidebar that contains a tab about your map, a tab that contains the contents of your map (such 

as layers) and also a tab that contains your legend. This sidebar also has 3 functions that allow 

you to see the details of your map, add a layer through the Add tab and finally a tab called 

Basemap that allows you to choose 1 of 9 basemaps that are available for free.  

 

Along the top there are some other important features such as the Save and Share options 

which will be discussed in greater detail in this tutorial.  

 
 

Choose a Basemap 

 

ArcGIS.com offers a variety of basemaps and the default one is ‘Topographic’. Click Basemap. 
This opens a tab containing nine different basemaps. Depending on the map you would like to 
produce, a different basemap may be appropriate. For this tutorial we will use the 
‘OpenStreetMap’ basemap. After selecting that basemap, your map will look like the image 
below.  
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Save your Map 

 
Next we are going to save the map we have begun creating. To do so you must click on 

the Save tab. Once you have clicked Save click on the ‘Save as’ option. This will open a 

‘Save Map’ message box. Enter an appropriate name and tags for your map and then click 

‘Save Map’ when finished. 

 

 

 

Searching for a Location and Creating Points, Lines and Polygons 

 

Finding a location on ArcGIS online 

 

Now that we have changed our basemap and saved our map, we need to find the location on 
the map we wish to view. This can be done by manually zooming into your map using your 
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mouse and scroll wheel, + - keys on your keyboard or the navigator control pan. You can also 
search an address in the search bar in the top right-hand corner of the screen. For this tutorial 
we would like to zoom into the main campus of the University of Waterloo.  

 

In the search bar type ‘200 University Ave West Waterloo Ontario’ and then click enter or the 

  symbol. Now your map should be zoomed into the university and should look like the 
image below.  

 
 

Adding a Map Note 

 

Next we are going to create a map note. Click ‘Add’ and then select ‘Add Map Notes’. This will 

bring out an ‘Add Map Notes’ message box. 

 
 

Assign a name and a template for the map notes.  For this tutorial we will set the name as 

‘Geospatial Centre’ and template as ‘Map Notes’. Click ‘Create’ when finish. You will notice 

that an ‘Add Feature’ table of contents appears on the left side. 
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Adding a Point Feature 

 

First we are going to add a point feature. You will see in the table of contents that you can 

select one of three different point features; a stickpin, pushpin or cross.  For this tutorial we will 

select the feature to be Pushpin. The next step is to double click to add the map note to the 

actual location of University of Waterloo Geospatial Centre, located in the Dana Porter Library. 

This will bring out a points message box. 

 

 
 

 

Complete the message box. Enter the following information into the box. Click close when finish. 
 

 
Title: Geospatial Centre 

Description: Dana Porter Library, Room 328 

Image URL: http://www.lib.uwaterloo.ca/locations/umd/collage/banner3.jpg 

Image Link URL: http://www.lib.uwaterloo.ca/locations/umd/index.html 

http://www.lib.uwaterloo.ca/locations/umd/collage/banner3.jpg
http://www.lib.uwaterloo.ca/locations/umd/index.html
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Adding a Line Feature 

 

For this tutorial, you are going to add a line feature by creating a path from the Geospatial Centre to 
Environment 1. From ‘Add Features’ table of contents, select ‘Line’. To create the path, single click 
on the map, starting at the Geospatial Centre, and complete the path ending at Environment 1 (as 
shown below). 

 

 
 
Double click to finalize it. You will see a new message box. Enter the information as shown below. 
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You can change the line symbol colour by clicking on ‘Change Symbol’. This will bring out a message 

box. Select a new color and optionally, you can change the line pattern, width, and transparency. 

Click ‘Done’ to confirm the change and ‘Close’ when finished. 
 

 
 

Add a Polygon Feature 

For this tutorial, you are going to create a polygon of the building outline for Dana Porter Library. 

From ‘Add Features’ table of contents, select ‘Area’. Next click on one of the building corners to start 

drawing. Double click at the last corner to complete the polygon. 
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Similar to the line feature, you can change the polygon’s colour, transparency as well as width by clicking 
‘Change Symbol’ in the message box. The next step is to pick a new color and set its transparency level 
to 50%. Click ‘Done’ and then ‘Close’ when finished. 

 

 

Saving your Map and Sharing it to the Public 

 

How to view your saved map in ‘My Contents’  

Your map is now complete! Simply click the save button to update the saved file of your map. You will 
see that it says ‘saving to my content’. 
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 To view your saved map click the ArcGIS tab in the top left-hand corner of the screen. This pulls down 
a message box that contains a tab called ‘My Contents’. If you click this tab it will take you to your 
contents which stores the saved maps as well as any uploaded files.  

 

Sharing your Saved Map 

 

After you have saved your map you have the option of sharing it. This can be done by clicking the 
share option next to save in the Map tab.  

 

After clicking ‘Everyone (public)’, you can share the link to your map as shown below. This will allow 
someone to follow the link on a web browser to view the map you have created.  
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Module 2: Adding and Symbolizing Layers 
This module will address how to add multiple layers to your map. With the latest release of ArcGIS.com, 

you can add a layer to your map that was stored in a delimited text file (.txt or .csv), a GPS Exchange 

Format file (.gpx), Keyhole Markup Language (kml), or a shapefile (compressed into a .zip). Once the 

layer is in ArcGIS.com, you can edit the layer properties, similar to symbolizing the point, line and 

polygon features in Module 1. For example, you can configure pop-up windows, change symbols, set 

visibility range, and enable editing. 

This tutorial shows you how to add a CSV file, a shapefile and a KML file into ArcGIS.com and then edit 

their layer properties. The files can be downloaded from the City of Vancouver data open website 

(http://data.vancouver.ca/). Details on how to download the files used are available in the appendix. 

Along with adding in data from outside sources as seen in this module, ArcGIS.com has an online data 

catalogue that includes over 10000 shapefiles. The data can be added to your map similarly to these 

other file types and can also be edited and shared to the public. To learn more about using ArcGIS.com’s 

online data, visit Module 5.  

How to Add a Layer to your Map 

 

 Open a new map 

For this portion of the tutorial we are going to create a new map that will be looking at the City 

of Vancouver. If you are unfamiliar with how to do so, check out the previous section called 

“Opening a Map, Adding a Basemap and then Saving it”. Choose the ‘Streetmap’ option for the 

basemap and save it as ‘Library and Firehall Locations in the City of Vancouver’ with appropriate 

tags.  

 

http://data.vancouver.ca/
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How to add a shapefile 

 

Now that you have your map set up with a basemap and saved to My Contents, you can now 

add a layer to your map. There are many ways to add a layer to your map including uploading it 

from a file on your computer, uploading from a file on the web, dragging it and dropping from a 

folder on your computer (csv, txt, and gpx files only), and searching for it either through ArcGIS’s 

online catalogue or from My Contents.  

 

For this tutorial, we are going to begin by adding the city boundary shapefile. To add a shapefile 

to ArcGIS online it must be compressed into a zip file and have generally fewer than 1,000 

features. Add the shapefile by clicking the Add tab and then clicking ‘Add layer from file’. 
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Browse your computer to the folder where the shapefile (zip file) is located and click ‘Import 

Layer’.  

 

 

When you see an image similar to the one shown below, that means the boundary shapefile has 

been added into ArcGIS.com as a new layer. 
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Adding a CSV file to your map 

 

In addition to importing shapefiles through map viewer by using the ‘Add’ button, you can 

upload a CSV file from the web or you can drag the CSV from a file on your computer. The 

comma-separated values text file (.csv) must include latitude and longitude information. There 

is however a limit of 1,000 records that can be imported to the map. 

 

Making an Interactive Spreadsheet 

 

To make an interactive spreadsheet on the web you must create or log in to your Google 

account. Once you have done this, you can upload the excel spreadsheet ‘Firehalls’ into the 

google drive, making sure to apply the settings as below.  

 
Once uploaded, the imported spreadsheet becomes a Google spreadsheet. Open the 

spreadsheet. In the ‘File’ menu select ‘Publish to the Web’.  

 

 
 

Next, click ‘Start publishing’. Set the published data format by opening the drop-down list and 

clicking CSV (comma-separated values).  
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Once the Firehalls spreadsheet is published, you can obtain a link to the published data. Copy 

and paste the link below so you can add it to your map.  

 

 
 

Adding the Interactive CSV file to your Map 

Now that you have the link to your published spreadsheet, you can add it to your map by 

clicking the Add tab and selecting ‘Add Layer from Web’.  
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Specify the type of data you are referencing as ‘CSV’ and paste the Google Drive URL link as 

shown below, then click ‘Add Layer’.  

 

 
 

Having a CSV file that is linked with your google drive allows you to create an interactive map. 

This means that any changes made on the spreadsheet will then appear on your map. Try out 

deleting or adding a new value to your spreadsheet in your google drive and update your map 

to see the changes that are made.   

 

Adding a CSV file through a ‘Drag and Drop’ method 

 

As well as adding the CSV file through the ‘Add Layer from Web’ interactive option, you can also 

drag and drop the FireHalls spreadsheet onto your map.  

 

Open your Window’s browser and navigate to the folder where the file is located. Click to select 

the ‘fireHalls.csv’ file and then drag and drop it onto the map. Once it is dropped into your map, 

you can then close the Windows’ explorer.
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Note: This feature does not work in Internet Explorer. Instead, simply just add the file by clicking 

‘add layer from file’ and select the ‘fireHalls.csv’ table. 

 

How to add a KML file to your Map 

 

To add a KML file to your map, begin by clicking on My Contents. This can either be found on the 

top tool bar or under the ArcGIS tab at the left side of the screen.  

 

 
 

To add a KML file into ArcGIS online, click ‘Add Item’ under the ‘My Contents’ tab. Select ‘The 

item is:’ as ‘On my Computer’. Browse to the folder where the libraries file is located and then 

click open. Enter an appropriate title and tags for the layer. When you are finished, click ‘Add 

Item’.  

 

Once you have uploaded the KML file, you will see a page similar to the one shown below. To be 

able to add the file to your map you must share it. To do this click ‘Share’ and indicate ‘Share the 

item with:’ ‘Everyone (public)’. Click ‘OK’ when finished.  
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Now that your file is shared to the public, you can add it to your already created map. Go back 

to your map titled ‘Library and Firehall Locations in the City of Vancouver’ and click the Add tab. 

Click on the option ‘Search for Layers’.  

 

A new panel will appear on the left side of your screen. Under the ‘Find:’ tab you can search tags 

to find the KML layers. Under the ‘In:’ tab, you can select where you would like to locate your 

data. For example you can search ‘ArcGIS online’ to view Esri’s online data catalogue or ‘My 

Contents’ to view files you have uploaded. To find the uploaded KML file, search in My Contents. 

You should see results such as below.  
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Select ‘Add’ to add the KML files to your map. Click ‘Done Adding Layers’ when you are finished.  

Your map may look something like below. It now has three different layers, but it may not be 

clear to your audience what these layers are. By symbolizing the layers, we can create an easy to 

read map that our viewers can understand.   

 

 

Symbolizing your Layers 

 
The next part of this tutorial will focus on briefly going over how to symbolize different layer types in 
ArcGIS online.  
 
Before we begin, just a reminder to periodically save your map throughout the tutorial to make sure no 
data or hard work is lost in the process.  
 
Symbolizing a shapefile in ArcGIS online 
 

For this part of the tutorial, you are going to symbolize the ‘city-boundary_shp’ layer. To begin, 
Move the cursor over ‘city-boundary_shp’ layer then click on the down arrow to show the message 
box. Click ‘rename’ and this will bring out a rename message box. 
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Type the new name as ‘City Boundary’ and click ‘OK’ when finished. 

 
 

To change the symbology of a layer, select ‘Change Symbol’ in the pull down options. For the 
purpose of this tutorial, lets change the symbology of the city boundary by selecting ‘A Single 
Symbol’ and click ‘Change Symbol’ to change its color, width, transparency and pattern. 
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Change the city boundary symbol to: Red color, Pattern as dash line, Transparency as 0%, Width as 

5 px and click ‘Apply’ to see the changes you have made, and then click ‘Done’ when finished. 

 

 

 

Symbolizing a CSV File in ArcGIS online 

 

Next we are going to change the symbology of the firehalls CSV file. To begin, click on the 

down arrow and select ‘Change Symbols’. Click Change Symbol again and it will open a new 

window containing different types of symbols you can use. It also includes the option to 

change the symbol size. Change the symbol of the firehalls to a red flag. Click ‘Done’ to 

close the ‘Change Symbol’ window and then ‘Done Changing Symbols’ to go back to your 

‘contents’ tab.  
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Next, click on any firehall location on the map. This will bring out a pop up message showing its 

attributes including name, latitude, longitude and address. 

 

 

Move the cursor over the ‘fireHalls’ layer and then click the down arrow to show the message box. 
Click ‘Configure Pop-up’. Next you can configure the pop-up message, title and its contents. This is 
viewed when you click on a point file in your layer.  
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By default, all field attributes will be displayed in the pop-up message. To remove unwanted 

attribute messages, click ‘Configure Attributes’. This will bring up a pop-up containing all fields 

that can be viewed when clicking on a point file in your map. Click on the ‘ADDRESS {ADDRESS}’ 

and ‘FIRE HALL NAME {FIRE HALL NAME}’ fields and click OK to confirm the change, and then 

‘Save Pop-up’ to save all changes you have made. 

 

 

Next we are going to enable the editing feature. This can be done by moving the cursor over the 
‘fireHalls’ layer and then clicking to show the message box. Click ‘Enable Editing’. A new tool will 
appear beside the Add tab as shown below.  

 
 

Now that the editing tool has been enabled, zoom in to the map and click on a fire hall location, this 
will bring out a pop-up message. Click ‘Edit’. 
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Next you have the choice of deleting the point by clicking ‘Delete’, moving the point, or 

modifying its attribute (address) in the address box. 

 

 
Under the edit tool, you can also add a new feature. This can be done by clicking the ‘New Feature’ 
symbol under the ‘Add Features’ table of contents. Next, click a point somewhere on the map 
where you want to add a point. 

 

 
 

Once you have chosen a location, a message box will appear as seen below. This is where you 

can enter an address and name to a new point location on your map. Add an address and click 

close.  

 



27 

 

 
 

How to Symbolize KML files in ArcGIS online 

ArcGIS online offers minimal settings to change the symbology of a KML file. The main function it allows 

for symbolizing is the transparency. This can be changed by clicking the down arrow to the right of the 

KML layer and changing the percentage as shown below.  

 

 
 

How to Symbolize and Style KML files in Google Earth 

 

If you would like to symbolize more than just the transparency of your KML file in ArcGIS online, you will 

have to use an outside source; Google Earth. If your computer does not have Google Earth, it can be 

downloaded for free at http://www.google.com/earth/index.html  

http://www.google.com/earth/index.html
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After you have either downloaded or opened Google Earth, begin by adding in the libraries KML file. This 

can be done by going to the File menu and selecting ‘open’. Navigate to the folder where the KML file is 

located. Select the file you would like to upload to Google Earth and then click ‘open’. You will find it 

under ‘Temporary Places’ on the left side of the screen.  

 
 

The above map is very crowded and it may be difficult to see the features you are looking for, so it is 

best to turn off some of the options under ‘Layers’ > ‘Primary Database’. Now that we can visibly see the 

library locations, let’s begin symbolizing. To start we are going to change the KML layer style. Right click 

the ‘libraries’ file under ‘Temporary Places’ and select ‘Properties’ 
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In ‘Google Earth – Edit Folder’ pop up window, you can click on the ‘Style, Colour’ tab. This tab 

allows you to edit your KML file, for example, changing the colour, and scale.  

 
 

Along with the style and colour, you can also change the symbol that your layer uses. For 

example, to the right of the ‘Name:’ section you can see the symbol that is currently being used 

(in this case it’s a green circle). By clicking the icon, it will open a new window that allows you to 

change the symbol used on the map. There are many different options that can be used, 

including well known symbols for things such as schools and airports, as well as plain icons that 

come in different colours and shapes. You can also create your own custom icon by adding in an 

image from a file on your computer.  
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Choose a different icon for the library file. For example you could use the green house with a 

flag on it and change the scale to 0.5.  Click ‘OK’ on both tabs to see your new icon on the map. 

 

 
 

Once you are satisfied with your new symbolized layer, you will need to save it to be able to add 

it back to your ArcGIS online map. Right click the layer you wish to save (under the Temporary 

Places tab) and select ‘Save Place As’.  
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In the ‘Save file…’ pop up window, navigate to the folder you wish to save the file and save it 

under the exact same name as the original. Make sure that under ‘Save as type:’ it says KML. 

Click ‘Save’.  

 

Updating KML files in ArcGIS online 

 

Now that the KML file has been symbolized and saved on to your computer, you will need to 

update the file that is currently on ArcGIS online. To begin, go to ‘My Contents’ and delete the 

old libraries file.  

 

Once the old file has been deleted, add the updated KML file into your contents, as explained 

earlier in this tutorial. Make sure it is shared to the public.  

 

 
 

Once your file is added to ‘My Content’, open up the map you were previously working on in 

‘My Contents’. This can be done by clicking the down arrow next to the layer name and selecting 

Open in ArcGIS online map viewer.  

 
 

Add the layer how you did previously by selecting ‘Search for Layers’ in ‘My Contents’ and add 

the updated layer to your map 
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Module 3: Saving your Map and Producing a Web Application 
In the third and final module you will learn how to save your finished map and produce a web 

application. By the end of this tutorial you will be familiar with all the tools used to save your 

map, how to share it to the public, and how to produce a web application.  

Saving your Final Map 

Now that you have finished adding and symbolizing all the layers, the map is now complete. 

Look over all your layers to make sure their names are written correctly and that the layers are 

symbolized to your liking. Now click Save > Save as.  

 

Check to make sure the title and tags are written correctly and click Save. Once completed, click 

the ‘Share’ tab next to ‘Save’. This will open up a pop-up ‘Share’ window as shown below.  
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How to Share your Map 

Now that we have the share pop-up open, we can explore the different types of methods that 

can be used to share the maps we make in ArcGIS online.  

Sharing to the Public 

As shown in Module 1, you can share your map to the public by clicking ‘Everyone (public)’ and 

copying the link provided. You can also share it on social media such as Facebook and twitter.   

Embedding your Map into a Website 

As well as sharing the map link, you can also embed the map in a website. To do so, click ‘Embed 

in Website’. This will lead to a new message box. In this message box you can choose a map size 

(Small, Medium, Large or Custom) and also add different options such as ‘Show zoom control’ 

and/or ‘Show scale bar’. Then copy and paste the HTML code to embed it in a website. Click 

‘Close’ when finished. 
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How to Make a Web Application 

Sharing your map through the link in the pop-up and creating an embedded map in a website 
are both simplisitc ways that you can share your map with others. Along with both of these, you 
can also create web applications.  

 

To begin, lets create a basic web application. To do so, in the same ‘Share’ pop-up, click ‘Make a 

Web Application’.  

 
 

This will open up a new window that shows you the many options of templates that are 
available for making a web application. We will begin by creating a basic ‘Legend’ application.  

 

Creating a Basic Web Application 

 

Similar to using any of the other basic applications, to select a specific one (in this case Legend) 
click the down arrow next to publish.  
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This pull down has three options, including publishing the application, downloading it, and 
previewing what it looks like.  

 

It is always a good idea to preview an application to see if it is visually what you are looking for. 
Once you have decided that it is fit for your map, click ‘Publish’.  

 

 

This will bring up a new window that will contain the title, tags and summary of your 

application. Fill in the appropriate information and click ‘Save & Publish’. A new window will 

appear as shown below. Click ‘go to this item now’ to share and configure your application.  
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This will open a new details page about your web application. Click ‘Share’ to share it with the 

public. Next, click ‘Open’ > ‘View Application’ to see the application you just created.  

 

You can now view your final web application.  

 

 

 How to create a Storytelling Map in ArcGIS Online 

 

Within the feature of ‘Web Applications’ you can create basic maps that allow your audience to 

see organized information that is visually appealing. There is also other options within the web 

applications that allow you to make more complex maps as well.  

 

One example of a more complex map is a Storytelling Map. These maps provide an easy way to 

publish your own story map using different story-telling techniques. To see examples of the 

many templates available follow the link http://storymaps.esri.com/templategallery/ 

 

 

http://storymaps.esri.com/templategallery/
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Simliar to the web application, you can create a Storytelling Map through the ‘make a web 

application’ option in the share window.  

 

Go back to your original map. Go through the share options again and  click on ‘make a web 

application’. When you browse through the options, you will see that some of them say 

‘storytelling’ in the title, for example ‘Storytelling Swipe’. For the purposes of this tutorial, lets 

create a Storytelling Map using this option.  

 

To begin, click the ‘Publish’ button in the drop down arrow of the application you wish to 

create.  

 

Do the same as you did for the regular application and fill in an appropriate title, tags and if 

applicable, a summary. Click ‘Save & Publish’ when finished.  

 

 Customizing your Storytelling Map 

  

Now that you have created a storytelling map, the next step is to customize it through a step-

by-step process beginning after you select ‘go to the item now’.  

 

Click ‘Open’ > ‘View Application’ and you should see a new page like the one below. 
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 You have now begun the process of creating your Storytelling Map.  

 

This great feature comes equipped with a ‘wizard’ tool that takes you through each step to 

successfully create your map.  

 

The first step is choosing what type of swipe tool you would like to use. This tool will ‘swipe’ 

away some data either through a vertical bar, or a spyglass. For this tutorial, let’s choose the 

‘Vertical Bar’ option. Then click ‘Apply’.  

 

The next step will ask you to choose which layer you are going to swipe away. In this case, you 

will want to swipe away to ‘Firehalls’ layer. Select that as your layer and select ‘Apply’.  
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The next step is selecting the application layout settings. This includes enabling and disabling 

what your audience will see on your map. You can try out different settings or leave them as 

default.  

 
 

Click ‘Apply’. This will bring you to your next step, which is customizing pop-ups. This is where 

you can name the headings for each side of the pop-up windows. Select heading names and 

then click Apply. The next three steps are more customization tools that will allow you to change 

the theme, header and extent. Look through these settings and change any that you see fit.  

 

When finished, click ‘Apply’ and you will see your Storytelling Map application.  

 
 

You can click the  tool to change your title and subtitle.  
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Do not forget to click the save option after every change you make. By clicking the ‘Settings’ 

option, it will take you back into the wizard where you can re-change or fix anything in your 

map.  

 

You can also write in a description on the left side where it currently says ‘Edit me!’.  

 

To see what your map will look like when the public view it, click the  icon. This will 

change your view to one where you cannot edit the map. This is where you can see how your 

audience will view it, and see if any more changes need to be made. You can also copy the link 

in the browser to share this map with others.  

 

 
 

Select the  ‘Switch to builder mode’ to go back to editable map. Map any more necessary 

changes and save your final Storytelling application.  

 

You have now created a Storytelling Map in ArcGIS online. This is just one of many storytelling 

web applications that you can create. Take the time to go through the link given above and 

explore the other storytelling templates available. There are many different types that may suite 

your specific needs.  

Module 4: Creating a Storytelling Map with ArcGIS online data 
Throughout this tutorial you have learned how to bring in and use outside sources of data in 

ArcGIS online to create maps. In this last module, you will learn about the features available to 

use data available on ArcGIS online’s website.  
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Adding Data from ESRI’s Online Catalogue 

As explained in Module 2, there are many different ways that data can be added to your map on 

ArcGIS.com. Instead of adding data from an outside source such as a city’s open data catalogue, 

you can also add in data that is available online in ESRI’s catalogue on ArcGIS.com. The 

catalogue includes over 10,000 shapefiles that can be added to your map including simple files 

such as boundaries and more complex files such as income and education levels.  

How to Add Data from ESRI’s Online Catalogue 

To view the layers available let’s begin by creating a new map. Once this map is created click the 

Add tab and select ‘Search for Layers’.  

 

This will open a new side panel as shown in Module 2. This time, instead of selecting ‘In: My 

Content’, select ‘In: ArcGIS Online’. You can search for a specific layer in the find search bar or 

browse the available options.  
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For this module, we are going to make a map that will compare income and education. The two 

shapefiles we will be searching for are ‘Canada: 2006 High School Education (Population over 

5,000)’ and ‘Canada: 2006 Median Household Income’.  

In the ‘Find:’ search bar type in key words to find each layer individually, such as ‘2006 high 

school education Canada’ then click ‘GO’.  Once you have found the layer click ‘Add’ to add it to 

your current map.  

If you are having trouble finding the layers, make sure to click off ‘Within map area’ or zoom out 

so that all of Canada is visible.  

 

Visually on your ArcGIS online map, you will only see one layer at a time, since they have the 

same coverage area. This may not result in the best map, but it does however allow you to 

create an interesting Storytelling Map.  

Creating a Storytelling Map with ArcGIS Online Data 

Before we can begin creating a Storytelling Map with ArcGIS’s online data, you must save your 

map. Save it using a relevant name such as ‘Income and Education Level Comparison Map’.  

Once you have saved your map, click the Share tab and select ‘Make a Web Application’.  
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Similar to Module 4, you will be creating a ‘Storytelling Swipe Application’. Compared to the 

previous Storytelling Map, this one will provide more information and allow you to see how data 

on maps can be used to make comparisons, correlations and inferences.  

Start creating your Swipe Application by clicking the ‘Publish’ button in the drop down arrow 

and then saving it. Once saved, open it via ‘go to this item now’. And Click Open > View 

Application.  

 

 

Once the application is open, use the ‘Application settings’ wizard tool to help you build your 

swipe application. Under ‘Swipe Style’ select ‘Vertical Bar’ and make sure under ‘Swipe Layer’ to 

choose the layer you added first to your original map, in this case ‘Canada: 2006 High School 

Education (Population over 5,000)’.  

 

Next, under ‘Pop-up’, you can name the headings that will appear when you click on specific 

locations on your map. Fill out the Information as shown below.  
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If for some reason the titles got mixed up and are incorrect, you can always go back and fix 

them later using the Settings tab. This reopens the ‘Application settings’ window to allow you 

make more changes. 

 

 

Continue to click ‘Apply’ under each settings tab and change what you think is necessary to 

create your Storytelling Application. When finished, your map should appear similar to the 

image below: 
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By using the swipe tool, you can examine different areas in Canada and, by clicking on specific 

locations, you can see the median household income as well as the high school education 

percentage. 

Click on a location in Southern Ontario. Swipe over the location and you will see the pop-up 

change from details about income to details about high school education.  

 

Now you have created an application that compares two values. From this application, you can 

decide if there is a correlation between the two points, or see if the layers do not relate at all. 

Applications such as this allow you to take your mapping experience a step further by taking the 

data you have added to your map and using it to come to conclusions about specific subjects.  
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Appendix A 

 

How to Download Shapefiles and KML files from City of Vancouver’s Open Data 

Catalogue 

 
Open the City of Vancouver’s Open Data Catalogue (http://data.vancouver.ca/) with an 
internet browser. You will see a webpage shown below. 

 

 
 

You can open the data catalogue by clicking 'view the list of datasets' under the 'explore the 

open data catalogue' tab on the home screen. You will see a page as shown below. Each dataset 

usually has more than one file format. Download the city boundary layer in the shapefile format, 

the fire halls layer in CSV format, and the libraries file in kml format.  

 

 

http://data.vancouver.ca/
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Appendix B 

 

Glossary of Terms 

Delimited Text File: A file in which the individual data values contain embedded delimiters, such as 

quotation marks, commas, and tabs. 

(http://support.sas.com/documentation/cdl/en/acpcref/63184/HTML/default/viewer.htm#a003103525

.htm) 

GPS Exchange Format File: GPX (the GPS Exchange Format) is a light-weight XML data format for the 

interchange of GPS data (waypoints, routes, and tracks) between applications and Web services on the 

Internet. (http://www.topografix.com/gpx.asp) 

Keyhole Markup Language:  A file format used to display geographic data in an Earth browser, such as 

Google Earth, Google Maps, and Google Maps for mobile (https://developers.google.com/kml/) 

Shapefile: A shapefile is a simple, nontopological format for storing the geometric location and attribute 

information of geographic features. Geographic features in a shapefile can be represented by points, 

lines, or polygons (areas). 

(http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//005600000002000000.htm) 
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